
Phần IV: Hướng dẫn sử dụng CNTT trong thiết kế đề kiểm tra  

Trong phần này, chúng tôi tập trung vào các nội dung sau đây: 

- Hướng dẫn sử dụng CNTT trong trình bày một đề kiểm tra nói chung. 
- Hướng dẫn thiết kế đề kiểm tra tự luận dựa trên ví dụ minh họa cụ thể. 
- Hướng dẫn thiết kế đề kiểm tra trắc nghiệm dựa trên ví dụ minh họa cụ thể. 

1. Trình bày đề kiểm tra 

Một đề kiểm tra bao gồm 2 phần: Phần thông tin chung của đề (và bảng ghi điểm – nhận xét nếu có) và 
phần nội dung.  

1.1. Trình bày thông tin đề kiểm tra và bảng ghi điểm - nhận xét 

a. Trình bày thông tin đề kiểm tra 

Phần thông tin chung sẽ ghi rõ những thông tin về đề kiểm tra như tên đơn vị, tên bài kiểm tra, năm học, 
môn học, lớp, thời gian làm bài…, ví dụ như sau:  

 
Các bước thực hiện:  

❶ Tạo bảng: Ta tạo bảng 2x2, với hàng trên chứa tất cả các thông tin được căn giữa và hàng dưới chứa 
phần ghi họ và tên, lớp.  

❷ Nhập các thông tin vào bảng và định dạng cho phần văn bản 

❸ Căn lề cho các nội dung và điều chỉnh kích thước các ô trong bảng: 

- Các thông tin trong hàng thứ nhất của bảng được căn giữa, hàng thứ hai được căn trái.  
- Điều chỉnh độ rộng của các ô sao cho phù hợp với nội dung bên trong.  
- Để tạo khoảng cách cho các nội dung trong bảng, ta điều chỉnh lại bằng cách nhấn chuột phải vào khoảng 

trắng bất kì và chọn Paragraph. Khi bảng Paragraph hiện ra, chỉnh khoảng cách giữa các đoạn tại 
Before/After và giãn dòng tại Line Spacing. Ví dụ:  

Before = After = 3pt; Line spacing = Multiple at 1.3 

❹ Ẩn viền bảng: Bấm chọn bảng rồi nhấn chuột phải, chọn biểu tượng Borders (các đường viền) và chọn 
No Border (không viền) 



 
b. Trình bày bảng ghi điểm – nhận xét 

- Một số mẫu bảng ghi điểm - nhận xét thường gặp: 

 

 

 
- Các bước thực hiện:  

❶ Tạo bảng, điều chỉnh kích thước các ô trong bảng 

❷ Gộp ô (Merge Cells) và tách ô (Split Cells) trong bảng: chọn (các) ô > chuột phải > chọn Merge 
Cells/ Split Cells. 



❸ Tạo dòng kẻ (…): Xem tại hướng dẫn  Tạo dòng kẻ bảng cách sử dụng Tabs 

❹ Chèn Text Box: Chọn Insert > Text Box 

1.2. Trình bày các mục trong đề kiểm tra 

Một đề kiểm tra cần được chia mục rõ ràng với các phần, các câu, các ý được thể hiện tường minh. Ta 
thường phân biệt các phần, các câu, các ý trong đề kiểm tra bằng cách định dạng khác nhau về khoảng cách 
so với lề, màu chữ, cỡ chữ, hoặc IN HOA, in đậm, in nghiêng, gạch chân, đóng khung, … 

Ví dụ:  

 

1.3. Chèn hình ảnh, bảng biểu và công thức vào đề kiểm tra 

Để chèn các đối tượng vào văn bản là nhấn chọn tab Insert trên thanh Ribbon. Trong tài liệu này, chúng 
tôi chỉ giới thiệu về một số đối tượng thường dùng trong soạn thảo nội dung phục vụ kiểm tra, đánh giá: 

a. Tables - Chèn bảng 
► Tạo bảng: Đặt con trỏ soạn thảo tại vị trí muốn chèn bảng. Trong tab Insert, nhấn chọn biểu biểu 
tượng Table, sau đó di chuyển con trỏ chuột để chọn số hàng và số cột của bảng. Hoặc bạn có thể nhấn 
chọn Insert Table… để nhập số hàng/số cột muốn tạo. 
► Chỉnh sửa bảng: Khi vừa chèn bảng xong, trên thanh Ribbon xuất hiện nhóm thẻ Table Tools với hai 
tab là Design và Layout, lúc này người dùng có thể nhập nội dung vào bảng và tiến hành chỉnh sửa bảng: 
- Thay đổi kích thước bảng: Đưa con trỏ chuột đến góc phải phía bên dưới của bảng, nhấn giữ vào mũi 

tên hai chiều và kéo rộng hoặc thu hẹp kích thước của bảng theo ý muốn.  
- Căn chỉnh vị trí, hướng của đoạn văn bản trong các ô của bảng: Chọn ô (hoặc nhiều ô) muốn căn chỉnh, 

nhấn chọn tab Layout trong Table Tools. Tại nhóm công cụ Alignment, người dùng có thể thể căn 
chỉnh vị trí hoặc đoạn văn bản trong ô; điều chỉnh lề của ô. 

- Thay đổi định dạng bảng: Chọn bảng muốn thay đổi định dạng, nhấn chọn tab Design trong Table 
Tools. Tại đây, người dùng có thể chọn các định dạng bảng có sẵn trong Table Styles hoặc tự điều chỉnh 
Shading (màu nền), Border Styles (kiểu viền) cho bảng. 



- Gộp ô: chọn các ô cần gộp, sau đó nhấn chuột phải và chọn Merge Cells.  
- Tách ô: đặt con trỏ chuột vào ô cần tách, sau đó nhấn chuột phải và chọn Split Cells. Sau khi hộp thoại 

Split Cells xuất hiện, nhập số cột và số hàng muốn tách thành và chọn OK. 

b. Illustration - Chèn minh họa 
Để chèn minh họa vào văn bản, người dùng sử dụng 
nhóm công cụ Illustration trong tab Insert của thanh 
Ribbon: 

(1) Pictures – Chèn hình ảnh từ máy tính 

(2) Online Pictures – Tìm kiếm và chèn hình 
ảnh từ các nguồn trực tuyến 

(3) Shapes – Vẽ hình từ những hình mẫu đã có sẵn 

(4) SmartArt – Chèn hình đồ họa SmartArt (hình tượng hóa các dữ liệu) 

(5) Chart – Chèn một biểu đồ 

(6) Screenshot – Chụp ảnh màn hình của một cửa sổ đang mở và chèn vào văn bản 

c.  Symbols – Chèn kí hiệu và công thức  
Để chèn các kí hiệu hoặc công thức vào văn bản, người dùng sử dụng nhóm công cụ Symbols trong tab 
Insert của thanh Ribbon như sau: 

- Chèn kí hiệu: Đặt con trỏ soạn thảo ở vị trí cần chèn, sau đó chọn Symbols > More Symbols. Khi hộp 
thoại Symbols xuất hiện, lụa chọn kí hiệu muốn chèn và nhấn chọn Insert. 

- Chèn công thức: Đặt con trỏ soạn thảo ở vị trí cần chèn, sau đó chọn Equation > Insert New Equation. 
Lúc này trên thanh Ribbon xuất hiện nhóm thẻ Equation > Design. Các cấu trúc toàn học cũng như các 
kí hiệu được hiển thị để người dùng có thể lựa chọn và nhập công thức: 

 

1.4. Trình bày hình ảnh minh họa  

Các hình ảnh minh họa trong đề kiểm tra phải được bố trí hợp lí, chúng ta cần chú ý những điều sau đây: 



a. Kích thước của hình ảnh 

►   Yêu cầu 

Các hình ảnh phải có kích thước đủ lớn để học sinh quan sát được nội dung bên trong, tuy nhiên cũng tránh 
để hình ảnh quá lớn gây lãng phí giấy.Đối với hình ảnh có chứa chữ, cần điều chỉnh cho cỡ chữ trong ảnh 
và trong đề thi không quá chênh lệch nhau. 

Ví dụ: Kích thước hình ảnh trong câu sau được cho là hợp lí: 

 
►   Cách thực hiện 

Để điều chỉnh kích thước của hình ảnh, nhấn chuột trái vào hình ảnh đó. Lúc này ở bốn góc và giữa các 
cạnh của hình ảnh sẽ xuất hiện các chấm tròn màu trắng: 

- Đặt con trỏ chuột ở một góc của hình ảnh để phóng to/thu nhỏ hình ảnh nhưng vẫn giữ nguyên tỉ lệ chiều 
dài : chiều rộng của ảnh 

- Đặt con trỏ chuột ở giữa một cạnh của hình ảnh để kéo giãn/co ảnh theo một chiều (tỉ lệ chiều dài : chiều 
rộng của ảnh bị thay đổi). 

b. Vị trí của hình ảnh 

►   Yêu cầu 

- Các hình ảnh cần được đặt ở vị trí hợp lí so với phần văn bản trong đề thi, tránh để trống quá nhiều diện 
tích và lãng phí giấy khi in ấn.  

- Ngoài ra, hình ảnh phải được gắn đúng ở vị trí tương ứng với nội dung bài tập, câu hỏi liên quan, tránh 
việc nhầm lẫn sang câu hỏi khác.  

Ví dụ:  

Hình ảnh trong câu sau được bố trí hợp lí:  

 



Hình ảnh trong câu sau được bố trí chưa hợp lí do để trống quá nhiều diện tích ở hai bên của hình ảnh: 

 
►   Cách thực hiện 

Để bố trí hình ảnh ở vị trí mong muốn, ta thực hiện như sau: 

Cách 1: Sử dụng Wrap Text 

❶ Nhấn chuột phải vào hình ảnh và chọn Wrap Text: 

 
❷ Tại đây tiếp tục chọn một trong các tùy chọn rồi di chuyển hình ảnh đến vị trí cần thiết:  

• In Line With Text: Văn bản và ảnh nằm trên 
cùng dòng 

• Square: Văn bản nằm xung quanh ảnh. 
• Tight: Văn bản nằm áp sát hai bên ảnh. 
• Through: Văn bản nằm áp sát xung quanh ảnh 

• Top and Bottom: Văn bản nằm trước và sau 
ảnh. 

• Behind Text: Văn bản hiển thị bên trên ảnh. 
• In Front of Text: Văn bản hiển thị bên dưới 

ảnh. 

Cách 2: Sử dụng bảng  

❶ Tạo một bảng gồm hai cột, copy phần văn bản dán vào cột thứ nhất và hình ảnh dán vào cột thứ hai : 

 
❷ Điều chỉnh kích thước cột sao cho phù hợp 
❸ Ân đi viền của bảng, ta thu được kết quả như sau:  



 
c. Màu sắc của hình ảnh  

►   Yêu cầu 

Hầu hết các đề kiểm tra thường được in đen trắng khiến cho các hình ảnh màu không được giữ nguyên màu 
như khi xem trên máy tính. Do đó khi chọn hình minh họa, cần đảm bảo màu sắc sau khi in không làm ảnh 
hưởng đến nội dung của câu hỏi/bài tập.  

  

Không phù hợp với in đen trắng Phù hợp với in đen trắng 

►   Cách thực hiện 

Khi vẽ một hình bất kì trong các phần mềm như Word, PowerPoint, Edraw Max,… ta có thể thay thế màu 
sắc của đối tượng bằng các họa tiết. Ví dụ như trong PowerPoint ta thực hiện như sau:  

❶ Nhấn chuột phải vào đối tượng và chọn Format Shape. Khi bảng Format Shape xuất hiện, nhấn chọn 
ô có biểu tượng hình thùng sơn (Fill & Line), tại đây ta có thể tùy chỉnh màu sắc của đối tượng theo từng 
phần: Fill (phần bên trong của hình) và Line (viền của hình).  

❷ Tùy chỉnh màu sắc của Fill và Line: 

- Tại mục Fill, nhấn chọn Pattern fill và kéo xuống phía dưới để chọn kiểu họa tiết. Sau đó, bạn có thể 
điều chỉnh màu của họa tiết ở Foreground và màu của nền bên trong ở Backgroud.  

- Tương tự, tại mục Line, bạn có thể chọn No line (không viền) hoặc Solid line (viền màu). Trong trường 
hợp chọn Solid line, bạn có thể tiếp tục tùy chỉnh màu sắc, độ trong suốt và độ dày của viền.  



 

 

Tùy chỉnh Fill Tùy chỉnh Line 

1.5. Tạo khoảng trống  

a. Một số dạng khoảng trống thường gặp 

Với các phiếu kiểm tra hoặc các bài tập điền vào chỗ trống đặc thù của bậc tiểu học, chúng ta thường bắt 
gặp một số dạng khoảng trống như: 

- Dòng kẻ để trả lời các câu hỏi tự luận. Ví dụ như:  

 
- Khoảng cách để điền từ/cụm từ. Ví dụ như:  

 
- Ô trống để tích đúng/sai, để điền số hoặc điền kí hiệu. Ví dụ như:  

 



b. Cách tạo khoảng trống  

►   Tạo dòng kẻ bằng cách sử dụng Tabs 

❶ Xác định điểm dừng của Tab 

- Trước hết, chúng ta cần bật hiển thị thanh Ruler (thanh thước) trong Word. Nếu trang Word của bạn 
đã hiển thị thanh thước, bạn có thể bỏ qua bước này. Nhấn chọn tab View, trong ô Show tích chọn ô 
Ruler, lúc này ta thấy thanh thước hiển thị ngay phía trên vùng soạn thảo như sau:  

 
- Xác định độ rộng của dòng kẻ muốn tạo bằng cách nhấn chuột trái vào khoảng thanh Ruler, sau đó giữ 

và kéo biểu tượng Tab trái (chữ L) đến điểm dừng của Tab mà bạn muốn.  

 
❷ Mở cài đặt Tabs: Nhấn chuột phải vào khoảng trắng bất kì trong vùng soạn thảo của Word và chọn 
Paragraph. Khi bảng Paragraph hiện lên, nhấn chọn Tabs ở góc dưới bên trái của bảng. 

❸ Thiết lập Tab: Trong bảng điều khiển Tabs chúng ta thấy 
hiển thị như hình bên. Trong đó:  

- Điểm dừng tab: ở vị trí mà bạn vừa chọn trên thanh Ruler 
- Alignment: Left do bạn vừa sử dụng tab trái 
- Trong mục Leader, nhấn chọn kiểu hiển thị của tab mà bạn 

muốn. Thông thường để tạo các dòng kẻ trống chúng ta có 
thể chọn kiểu số 2 hoặc số 3.  

- Nhấn chọn Set > OK 

❹ Sử dụng Tab vừa tạo: Đặt con trỏ soạn thảo ở vị trí mà bạn 
muốn thêm dòng kẻ, sau đó nhấn phím Tab (bên cạnh phím 
Caps lock) trên bàn phím để tạo dòng kẻ. Mỗi lần nhấn phím 
Tab tương ứng với một dòng kẻ được tạo.  

 

 



►   Tạo khoảng cách 

Việc tạo khoảng cách để điền các từ/cụm từ tương đối đơn giản. Bạn có thể sử dụng một dãy các dấu chấm 
(………) hoặc dấu gạch dưới (_______), tuy nhiên cần chú ý độ dài của khoảng cách phải đủ lớn để học 
sinh có thể viết được hết từ/cụm từ cần điền.  

►   Tạo ô trống  
Có rất nhiều kiểu tạo ô trống khác nhau trong các bài tập dành cho học sinh tiểu học. Chúng ta tìm hiểu cách 
tạo ô trống thông qua 2 ví dụ sau: 

Ví dụ 1: Soạn thảo câu hỏi theo đúng hình thức trong hình ảnh sau:   

 
Thực hiện 

❶ Soạn thảo nội dung cơ bản của bài tập 

❷ Thêm ô trống vào các cột bằng cách sau đây: 

- Nhấn chọn File > Options > Customize Ribbon, đánh dấu vào ô Developer và nhấn OK.  

 
- Đặt con trỏ soạn thảo vào vị trí cần chèn ô trống, nhấn chọn tab Developer vừa xuất hiện trên thanh 

Ribbon, tại đây nhấn chọn biểu tượng ô có dấu tích trong nhóm Controls.  



 
- Ta thu được các ô trống như sau:  

 
❸ Tạo ô trống có đánh dấu: 

- Nhấn chuột trái vào một trong các ô trống vừa tạo, trong ô trống xuất hiện dấu gạch chéo (х) như sau: 

 
- Tương tự, nếu nhấn chuột trái vào ô đó lần nữa, ô gạch chéo lại trở về thành ô trống.  

❹ Thay thế dấu gạch chéo (х) bằng dấu tích (ü) 

- Nhấn chọn một ô trống bất kì, sau đó nhấn chọn tab Developer > Properties như sau:   

 
- Khi bảng Content Control Properties mở ra, ở dòng Checked symbol nhấn chọn Change:  
- Trong bảng Symbol vừa hiện lên, chọn font Wingdings, sau đó kéo thanh cuộn xuống cuối cùng, chọn 

kí hiệu dấu tích trong ô vuông và nhấn chọn OK:  

 



- Lúc này chúng ta thu được kết quả như sau:  

 
Tương tự như trên, bạn cũng có thể thay thế dấu tích bằng các kí hiệu khác trong Symbol.   

❺ Cuối cùng, điều chỉnh định dạng các nội dung cho giống mẫu, bỏ viền của bảng ta được kết quả sau:

 
Ví dụ 2:   

Vẽ lại sơ đồ trong hình ảnh dưới đây:   

 
Thực hiện 

Để vẽ được sơ đồ gồm các ô trống với hình dạng khác nhau như trên, chúng ta có thể vẽ trực tiếp trên Word, 
tuy nhiên để thao tác đơn giản nhất, ta nên sử dụng vẽ hình bằng PowerPoint. Nếu bạn thực hiện trên Word, 
các thao tác cũng tương tự. 

❶ Chèn các hình độ cao bằng nhau 

- Trong giao diện làm việc của PowerPoint, nhấn chọn tab Insert > Shapes. Khi danh sách các hình 
được thả xuống, nhấn chọn. 

 
- Chọn một hình rồi đặt con trỏ chuột xuống, nhấn giữ chuột trái kéo để tạo và điều chỉnh tỉ lệ, kích thước 

của hình. Lần lượt làm tương tự ta thu được các hình như sau:  



 
- Nhấn tổ hợp phím Ctrl + A hoặc nhấn giữ chuột trái và kéo điều chỉnh phạm vi để chọn tất cả các hình. 

Sau đó nhấn chuột phải chọn Format Object…: 
- Khi bảng Format Shapes hiện lên, nhấn chọn biểu tượng Size & Properties, đánh dấu vào ô Lock 

aspect ratio (khóa tỉ lệ khung hình). Sau đó nhập độ cao mong muốn vào ô Height (chiều cao) rồi nhấn 
phím Enter. Như vậy, ta đã thu được các hình có độ cao bằng nhau: 

 

 

❷ Thêm mũi tên vào giữa các hình 

- Nhấn chọn tab Insert và chọn Shapes, tại đây chọn biểu tượng mũi tên một chiều. Sau đó đặt chuột trái 
vào vị trí trung điểm cạnh của hình vuông, nhấn giữ và kéo để mũi tên có độ dài thích hợp.  

 
- Di chuyển hình oval đến sau mũi tên sao (trong khi di chuyển đến gần 

mũi tên, các đường kẻ nét đứt sẽ xuất hiện giúp ta xác định các vị trí 
nào thẳng hàng nhau, vị trí trung tâm nằm ở đâu…) 

- Dùng cặp lệnh Copy/Paste (Ctrl + C/Ctrl + V) để sao chép và dán 
mũi tên phía trước và đặt nối tiếp vào phía sau hình oval, sau đó di chuyển hình lục giáo vào vị trí sau 
mũi tên… Thực hiện tương tự với các hình còn lại. 

❸ Điều chỉnh màu viền và màu bên trong các hình 



- Nhấn tổ hợp phím Ctrl + A hoặc nhấn giữ chuột trái và kéo điều chỉnh phạm vi để chọn tất cả các hình. 
Sau đó nhấn chuột phải chọn Format Object…: 

- Khi bảng Format Shapes hiện lên, nhấn chọn biểu tượng Fill & Line (hình thùng sơn) rồi tùy chọn cho 
mỗi mục như sau:  

• Fill: No color • Line: Solid Line > Chọn màu đen 
- Kết quả là ta thu được hình sau:  

 
❹ Thêm chữ và số vào hình 

- Nhấn chuột phải vào ô vuông đầu tiên, chọn Edit Text và nhập số vào. 
- Nhấn chọn tab Insert > Text Box và đặt con trỏ chuột xuống vị trí bất kì để chèn Text Box. Nhập nội 

dung của Text Box rồi di chuyển Text Box đó đến vị trí bên trên mũi tên thứ nhất.  

 
- Thực hiện tương tự với các chữ số còn lại:  

 
❺ Nhóm các hình lại và lưu thành file ảnh 

- Nhấn tổ hợp phím Ctrl + A, sau đó nhấn chuột phải và chọn Group > Group (hoặc tổ hợp phím Ctrl 
+ G). Lúc này tất cả các hình đã tạo đã được gộp thành một nhóm: 

 
- Nhấn chuột phải vào nhóm trên, chọn Save as picture, đặt tên file và chọn thư mục lưu trữ, sau đó nhấn 

Save để hoàn tất.  

2. Thiết kế đề kiểm tra tự luận  

Trên đây chúng ta đã tìm hiểu cách trình bày một đề kiểm tra nói chung. Trong phần này, chúng tôi hướng 
dẫn cụ thể cách thiết kế một đề kiểm tra tự luận thông qua ví dụ với nội dung cụ thể. Lưu ý rằng ví dụ sau 
đây chỉ được dùng để minh họa các thao tác sử dụng CNTT, không bàn thêm về mặt nội dung.  

Dựa trên nội dung của một đề kiểm tra sau đây, chúng ta sẽ thiết kế thành một phiếu kiểm tra tự luận hoàn 
chỉnh: 



Đề kiểm tra học kì môn Toán 
Bài 1 (1 điểm). 
a) Ghi lại cách đọc các số sau:  

451,03;   

b) Viết số thập phân gồm: 
Sáu đơn vị, hai phần trăm; Một nghìn không trăm mười tám đơn vị, năm phần nghìn 
Bài 2 (1 điểm). Điền dấu “ >”, “<”, “=” vào ô trống:  
321,089 ……. 321,1;         536,4 ……… 536,400;         534,1 ………... 533,99;     98,532 ……… 98,45 
Bài 3 (2 điểm). Đặt tính rồi tính: 
 458,7 + 23,4;                5,23  31,2;             321,5 – 47;            148,8 : 6,2 
Bài 4 (1 điểm). Điền vào chỗ trống: 
Giá trị của chữ số 4 ở phần thập phân trong số 53,214 là  

Số  được viết dưới dạng số thập phân là  

Bài 5 (1 điểm). Tìm  biết 
;                                

Bài 6 (1 điểm). Viết số thập phân thích hợp vào chỗ chấm:  
8km 32m = ……………….km;                                 1056dm2 = ……………….m2 
3 tấn 2 tạ = ……………….tấn                                     7 giờ 15 phút = ……………….giờ 
Bài 7 (2 điểm). Một mảnh vườn hình chữ nhật có nửa chu vi là 28m. Chiều rộng bằng 40% chiều dài. 
a) Tính diện tích mảnh vườn đó. 
b) Người ta sử dụng 5% diện tích mảnh vườn làm lối đi. Tính diện tích của lối đi. 
Bài 8 (1 điểm). Ông A gửi tiền vào ngân hàng với lãi suất tiết kiệm một tháng là 0,65%. Để sau 1 tháng 
nhận được tiền lãi là 975000 đồng thì ông A phải gửi bao nhiêu tiền? 

2.1. Trình bày thông tin đề kiểm tra và bảng ghi điểm - nhận xét 

a. Trình bày thông tin đề kiểm tra 

Từ các thông tin về đề kiểm tra đã có, ta trình bày lại thành bảng thông tin đề kiểm tra như sau: 

PHÒNG GD&ĐT…………….. 

TRƯỜNG …….. 

(Phiểu kiểm tra gồm có … trang) 

KIỂM TRA CUỐI HỌC KÌ I 

NĂM HỌC 2019– 2020 

Môn: Toán – Lớp:  

Thời gian: 40 phút 

Họ và tên: ………………………………………… Lớp: ………… 

b. Trình bày bảng ghi điểm – nhận xét 

Để thiết kế đề kiểm tra dưới dạng phiếu (học sinh làm bài trực tiếp trên phiếu), chúng ta cần bổ sung bảng 
ghi điểm – nhận xét. Chẳng hạn như sau: 

532
18

´

6746
100

x
12,6 6,54 5x - = ´ 12 25,2 : 2,1x´ =



 

2.2. Trình bày nội dung của đề  

a. Trình bày các đề mục 

Đề kiểm tra trên gồm có 8 bài tập và trong một số bài có các ý nhỏ. Ta có thể đánh dấu các ý, các bài như 
sau:  

- In đậm các từ “Bài 1”, “Bài 2”… hoặc thay thế chúng bằng các kí hiệu như ❶, ❷ (Insert > Symbol > 
More Symbols > chọn font = Calibri và Subset = Dingbats)... 

- Xóa các kí tự “a)”, “b)” trước các ý trong một bài và thay thế bằng cách sử dụng đánh số tự động. 
- Sử dụng Increase Indent để các ý  thụt vào một đoạn nhỏ 

so với bài: nhấn chọn Home > trong nhóm công cụ 
Paragraph tìm đến biểu tượng dịch chuyển về bên phải 
như hình bên. 

 

- Nếu mỗi ý trong bài tương đối ngắn, có thể đặt 2, ,3 
hoặc 4 ý trên cùng 1 dòng bằng cách chia cột: chọn 
các ý > Layout > Columns > chọn số cột trong danh 
sách gợi ý hoặc nhấn chọn More Columns… 

Chẳng hạn với bài 3: 

 
b. Tạo khoảng trống 
Chúng ta bổ sung khoảng trống cần thiết cho các bài tập như sau:  

- Các bài 1, 3, 4, 5, 7, 8 cần bổ sung khoảng trống dưới dạng dòng kẻ (sử dụng Tabs), có tính toán số 
dòng mà học sinh cần để giải mỗi bài.  

- Bài 2 cần bổ sung khoảng trống dưới dạng ô trống. Để tạo các ô trống này chúng ta tạo bảng như hình 
dưới đây. Sau đó giữ lại viền của các vùng ô màu vàng, ẩn đi các viền còn lại: 

321,089  321,1  534,1  533,99 
       
536,4  536,400  98,532  98,45 

Kết quả thu được như sau:  



 
- Bài 6 cần bổ sung khoảng trống dưới dạng một dãy các dấu chấm, đồng thời cũng sử dụng cách chia 

cột tương tự bài 2. 

 

2.3. Các điều chỉnh khác 

- Cài đặt khoảng cách lề tại Layout > Margins 
- Font chữ: Time New Romans, cỡ chữ: 13  
- Cài đặt giãn dòng và khoảng cách đoạn tại Paragraph (nhấn chuột 

phải chọn Paragraph) hoặc nhấn chọn Home, trong nhóm công 
cụ Paragraph nhấn chọn mũi tên như hình bên.  

2.4. Kết quả 
Cuối cùng chúng ta thu được đề kiểm tra tự luận như sau:



PHÒNG GD&ĐT…………….. 
TRƯỜNG TIỂU HỌC…….. 

(Phiểu kiểm tra gồm có 02 trang) 

KIỂM TRA CUỐI HỌC KÌ I 
NĂM HỌC 2019 – 2020 

Môn: Toán – Lớp: 5 
Thời gian: 40 phút 

Họ và tên: ………………………………………… Lớp: ………… 
 
 
 
 
 
 

 

 
❶ (1 điểm). 

a) Ghi lại cách đọc các số sau:  
451,03  ............................................................................................................................................  

  .............................................................................................................................................  

b) Viết số thập phân gồm: 
Sáu đơn vị, hai phần trăm: ..............................................................................................................  
Một nghìn không trăm mười tám đơn vị, năm phần nghìn .............................................................  

❷ (1 điểm). Điền dấu “ >”, “<”, “=” vào ô trống:  

321,089  321,1  534,1  533,99 
       
536,4  536,400  98,532  98,45 

❸ (2 điểm). Đặt tính rồi tính:
458,7 + 23,4 5,23  31,2 321,5 – 47 148,8 : 6,2 

 ....................................................................................................................................................................  
 ....................................................................................................................................................................  
 ....................................................................................................................................................................  
 ....................................................................................................................................................................  
❹ (1 điểm). Điền vào chỗ trống: 
Giá trị của chữ số 4 ở phần thập phân trong số 53,214 là  .........................................................................  

Số  được viết dưới dạng số thập phân là  .......................................................................................  

 
❺ (1 điểm). Tìm  biết 

  

532
18

´

6746
100

x
12,6 6,54 5x - = ´ 12 25,2 : 2,1x´ =

Điểm Nhận xét của giáo viên 



 ....................................................................................................................................................................  
 ....................................................................................................................................................................  
 ....................................................................................................................................................................  
❻ (1 điểm). Viết số thập phân thích hợp vào chỗ chấm:

8km 32m = ……………….km 
1056dm2 = ……………….m2 

3 tấn 2 tạ = ……………….tấn 
7 giờ 15 phút = ……………….giờ 

❼ (2 điểm). Một mảnh vườn hình chữ nhật có nửa chu vi là 28m. Chiều rộng bằng 40% chiều dài. 
a) Tính diện tích mảnh vườn đó. 
b) Người ta sử dụng 5% diện tích mảnh vườn làm lối đi. Tính diện tích của lối đi. 

Lời giải 
 ....................................................................................................................................................................  
 ....................................................................................................................................................................  
 ....................................................................................................................................................................  
 ....................................................................................................................................................................  
 ....................................................................................................................................................................  
 ....................................................................................................................................................................  
 ....................................................................................................................................................................  
 ....................................................................................................................................................................  
 ....................................................................................................................................................................  
 ....................................................................................................................................................................  
 ....................................................................................................................................................................  
 ....................................................................................................................................................................  
 ....................................................................................................................................................................  
 ....................................................................................................................................................................  
❽ (1 điểm). Ông A gửi tiền vào ngân hàng với lãi suất tiết kiệm một tháng là 0,65%. Để sau 1 tháng nhận 
được tiền lãi là 975000 đồng thì ông A phải gửi bao nhiêu tiền? 

Lời giải 
 ....................................................................................................................................................................  
 ....................................................................................................................................................................  
 ....................................................................................................................................................................  
 ....................................................................................................................................................................  

-------- HẾT-------- 



3. Thiết kế đề kiểm tra trắc nghiệm  

Tương tự như với đề tự luận, trong phần này chúng tôi hướng dẫn cụ thể cách thiết kế một đề kiểm tra trắc 
nghiệm thông qua ví dụ với nội dung cụ thể. Lưu ý rằng ví dụ sau đây chỉ được dùng để minh họa các thao 
tác sử dụng CNTT, không bàn thêm về mặt nội dung.  

Dựa trên nội dung của một đề kiểm tra sau đây, chúng ta sẽ thiết kế thành một phiếu kiểm tra trắc nghiệm 
hoàn chỉnh: 

Kiểm tra cuối năm học  
Bài 1: Đánh dấu vào ô trống trước các câu trả lời phù hợp với ý kiến của em: 
a) Các bộ phận của cơ quan thần kinh gồm có 
Não; Tủy sống; Tai; Mũi; Hộp sọ; Dây thần kinh 
b) Nguyên nhân nào dưới đây dẫn đến bệnh thấp tim? 
Do viêm họng, viêm a-mi-đan kéo dài. 
Do ăn uống không hợp vệ sinh. 
Do biến chứng các bệnh truyền nhiễm.  
Do thấp khớp không được chữa trị kịp thời và dứt điểm.  
c) Em sẽ làm gì khi thấy bạn khác chơi trò nguy hiểm? 
Không làm gì.  
Cùng tham gia chơi trò chơi đó. 
Báo cho thầy cô giáo hoặc người lớn biết. 
Khuyên bạn không nên chơi trò chơi đó. 
Bài 2:  Nối các ý ở cột A với các ý ở cột B sao cho phù hợp 

Cột A Cột B 
Nhiệt đới Rất lạnh, ở hai cực Trái Đất, quanh năm nước đóng băng 
Ôn đới Thường nóng quanh năm 
Hàn đới Ôn hòa, có đủ bốn mùa: xuân, hạ, thu, đông 

Bài 3: Cho các hình được đánh số từ trái sang phải sau đây: 
Hình 1: Lan và bố mẹ, em trai của Lan; Hình 2: Ông bà nội của Lan; Hình 3: Bố của Lan và em trai của 
bố 

                                   
 
Em hãy nối các ô phía dưới với người phù hợp: 



 

 
 

 
Con trai của ông bà nội Lan Chú của Lan Con dâu của ông bà nội Lan 

 
Bài 4: Khoanh tròn vào chữ cái đứng trước phương án đúng 
a) Hoạt động nào sau đây là hoạt động nông nghiệp? 
A. Trồng lúa và nuôi lợn. 
B. Khai thác than, 
C. Sản xuất gang thép. 
D. Kinh doanh khách sạn.  
b) Vai trò của não là  
A. điều khiển mắt.  
B. điều khiển moi hoạt động của cơ thể. 
C. điều khiển cơ quan thần kinh.  
D. điều khiển cơ quan tuần hoàn.  
c) Những cơ sở thông tin liên lạc là  
A. bưu điện, đài phát thanh, nhà máy.  
B. bưu điện, đài truyền hình, đài phát thanh.  
C. đài phát thanh, trường học, bệnh viện.  
D. đài phát thanh, đài truyền hình, nhà máy.  
d) Phát biểu nào sau đây đúng 
A. Mặt Trời vừa quay quanh Trái Đất và vừa quay quanh chính nó.  
B. Trái Đất  vừa quay quanh Mặt Trời và vừa quay quanh chính nó. 
C. Trái Đất quay xung quanh Mặt Trăng. 
D. Mặt Trời quanh xung quanh Mặt Trăng và Trái Đất. 
Bài 5: Cho các loài động vật sau đây: bò sữa, cua biển, trâu, chim bồ câu, mèo, muỗi, cá chép, dê, họa 
mi, vẹt, cá vàng, ong mật, châu chấu, tôm hùm. Hãy điền tên các loài động vật trên vào bảng sao cho 
phù hợp.  

Côn trùng Tôm, cua Cá Chim Thú 
 
 

    
 

3.1. Trình bày thông tin đề kiểm tra và bảng ghi điểm - nhận xét 
Tương tự như đối với đề tự luận, ta bổ sung bảng ghi thông tin đề kiểm tra và bảng ghi điểm – nhận xét.  

3.2. Trình bày nội dung của đề  

a. Trình bày các đề mục 

Ta đánh dấu các bài bài và các ý tương tự như với đề kiểm tra tự luận. Ngoài ra cần in đậm các tên cột trong 
bảng và các chữ cái đứng trước các phương án. 



b. Trình bày hình ảnh minh họa 

- Ta có thể trình bày các hình ảnh trong bài 3 bằng cách sử dụng bảng và chú thích trực tiếp phía dưới. 

Các hình trong bảng đã tương đối tách biệt với nhau, ta có thể ẩn viền bên trong của bảng đi để tạo 
cảm giác dễ chịu hơn.  

- Tăng khoảng cách giữa phần hình và các ô bên dưới; đồng thời căn chỉnh lại các ô chữ như sau (giữ 
viền của các ô màu vàng và ẩn viền của các phần còn lại).  

 

 

 

 

 

Con trai của ông bà nội Lan  Chú của Lan  Con dâu của ông bà nội Lan 

c. Tạo khoảng trống 

- Thực hiện tạo ô các ô vuông như hướng dẫn ở mục 1.1.4.b. Tạo ô trống cho Bài 1. Tuy nhiên ta cần bố 
trí lại các ý vào bảng sao cho trang đề thi không bị trống nhiều, gây lãng phí giấy. Chẳng hạn với ý a) 
của Bài 1, ta đưa các nội dung vào bảng như sau (sau đó ẩn đi toàn bộ viền của bảng):  
a) Các bộ phận của cơ quan thần kinh gồm có 

☐ Não  ☐ Tủy sống  ☐ Tai 

☐ Mũi  ☐ Hộp sọ  ☐ Dây thần kinh 

- Cần lưu ý rằng để điều chỉnh kích thước của các ô vuông, ta có thể thay đổi cỡ chữ như với các kí tự 
khác.  

3.3. Các điều chỉnh khác 

Ngoài các điều chỉnh như cài đặt khoảng cách lề , font chữ, cỡ chữ, giãn dòng và khoảng cách đoạn… tương 
tự như với đề tự luận; do đặc thù của đề trắc nghiệm là gồm nhiều ý ngắn, nên để trang đề thi không bị trống 
nhiều, ta thực hiện căn chỉnh các phương án của Bài 4 như sau: Chọn (bôi đen 4 phương án) > nhấn chọn 
Layout > Columns > chọn số cột (tùy thuộc phương án dài hay ngắn). Chẳng hạn với ý a) của Bài 4: 

a) Hoạt động nào sau đây là hoạt động nông nghiệp? 

A. Trồng lúa và nuôi lợn. B. Khai thác than, 



C. Sản xuất gang thép. D. Kinh doanh khách sạn.  

3.4. Kết quả 

Cuối cùng chúng ta thu được phiếu kiểm tra trắc nghiệm như sau:



SỞ GD&ĐT…………….. 
TRƯỜNG …….. 

(Phiểu kiểm tra gồm có 02 trang) 

KIỂM TRA CUỐI HỌC KÌ I 
NĂM HỌC 2019 – 2020 
Môn: …….. Lớp: ……. 

Thời gian: 40 phút 

Họ và tên: ………………………………………… Lớp: ………… 
 

Điểm 
 
 
 
 

Nhận xét của giáo viên 

 
❶ Đánh dấu vào ô trống trước các câu trả lời phù hợp với ý kiến của em: 

b) Các bộ phận của cơ quan thần kinh gồm có 

☐ Não  ☐ Tủy sống  ☐ Tai 

☐ Mũi  ☐ Hộp sọ  ☐ Dây thần kinh 

c) Nguyên nhân nào dưới đây dẫn đến bệnh thấp tim? 

☐ 
Do viêm họng, viêm a-mi-đan kéo 
dài. 

 
☐ Do ăn uống không hợp vệ sinh. 

☐ 
Do biến chứng các bệnh truyền 
nhiễm. 

 
☐ 

Do thấp khớp không được chữa trị 
kịp thời và dứt điểm.  

d) Em sẽ làm gì khi thấy bạn khác chơi trò nguy hiểm? 

☐ Không làm gì.  ☐ Cùng tham gia chơi trò chơi đó. 

☐ 
Báo cho thầy cô giáo hoặc 
người lớn biết. 

 
☐ 

Khuyên bạn không nên chơi trò chơi 
đó. 

❷ Nối các ý ở cột A với các ý ở cột B sao cho phù hợp 

Cột A  Cột B 

Nhiệt đới  Rất lạnh, ở hai cực Trái Đất, quanh năm nước đóng băng 

Ôn đới  Thường nóng quanh năm 

Hàn đới  Ôn hòa, có đủ bốn mùa: xuân, hạ, thu, đông 

❸ Cho hình sau đây: 



 

  

Lan và bố mẹ, em trai của  Lan Ông bà nội của Lan Bố của Lan và em trai của bố 

Em hãy nối các ô phía dưới với người phù hợp:  

 

  

 
 
 
 

Con trai của ông bà nội Lan  Chú của Lan  Con dâu của ông bà nội Lan 

 
❹ Khoanh tròn vào chữ cái đứng trước phương án đúng 

b) Hoạt động nào sau đây là hoạt động nông nghiệp? 

A. Trồng lúa và nuôi lợn. 
B. Khai thác than, 

C. Sản xuất gang thép. 
D. Kinh doanh khách sạn.  

c) Vai trò của não là  

A. điều khiển mắt.  
B. điều khiển moi hoạt động của cơ thể. 

C. điều khiển cơ quan thần kinh.  
D. điều khiển cơ quan tuần hoàn. 

d) Những cơ sở thông tin liên lạc là  
A. bưu điện, đài phát thanh, nhà máy.  



B. bưu điện, đài truyền hình, đài phát thanh.  
C. đài phát thanh, trường học, bệnh viện.  
D. đài phát thanh, đài truyền hình, nhà máy.  

e) Phát biểu nào sau đây đúng 
A. Mặt Trời vừa quay quanh Trái Đất và vừa quay quanh chính nó.  
B. Trái Đất  vừa quay quanh Mặt Trời và vừa quay quanh chính nó. 
C. Trái Đất quay xung quanh Mặt Trăng. 
D. Mặt Trời quanh xung quanh Mặt Trăng và Trái Đất. 

❺ Cho các loài động vật sau đây: bò sữa, cua biển, trâu, chim bồ câu, mèo, muỗi, cá chép, dê, họa mi, vẹt, 
cá vàng, ong mật, châu chấu, tôm hùm. Hãy điền tên các loài động vật trên vào bảng sao cho phù hợp.  

Côn trùng Tôm, cua Cá Chim Thú 

 
 
 

    

 
-------- HẾT-------



 


